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  HCA Client Accounting  

Quick Start Training Manual 11/07/2014 
  

All Windows Version Compatible 
 

Please contact Support for any questions or help 
 
 

 
 

HCA is a powerful reporting program, this quick start manual gives you a brief overview of the program 
to help you get setup and running quickly. Please review some of the sample clients to see the excellent 
reporting options that are available for your clients. The main manual details the advanced features of the 
software and we are currently updating all of our manuals for the new HCA programs. We have just 
finished major upgrades to the program and our main manuals are definetly outdated but the operations 
of the programs are basically the same. 
 
Please feel free to call us with any questions you may have while evaluating the Demo program, we will 
be happy to exist you in anyway. 
 
 

 

http://www.hcasoftware.com/support.html
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HCA LICENSE AGREEMENT  

All HCA programs are licensed by HCA to the original purchaser for their use only, and these programs 
and their related manuals may not be copied or distributed in any form or media to any person or 
persons who are not licensed by HCA. In no event will HCA or any of its owners, employees, or dealers be 
liable to any person for any direct, incidental or consequential damages arising out of the use or inability 
to use the programs.  

Passwords for downloading HCA QLink 

Password = ________________________  Password = ________________________ 

Laser Forms Payroll & Check Writer 
Password = ________________________  Password = ________________________ 

SUPPORT & SERVICE POLICY  
 
For over 30 years our support has been free, we only require that your software is updated annually. 
We are always looking for ways to provide better support (remote hookup is our newest 
enhancement) 

 

• INTERNET SUPPORT  
 

Our web page is www.hcasoftware.com and our E-mail address is 
support@howellsoftware.com Our web page has a Menu Selection named Downloads where 
you can download any new programs and updates throughout the year. Email support is 
monitored continuously and is the quickest way to receive support. The Support menu at the 
web site has an option to submit a Support Ticket and to attach a backup of any client files, if 
needed. 

• TELEPHONE SUPPORT  
 

9 AM to 4 PM eastern time on normal business days @ (352) 589-6438  

Fax: (888) 221-4448  

HCA  
33811 Venice Lane 
Sorrento, FL 32776 
 
 
 
 
  

http://www.hcasoftware.com/
mailto:support@howellsoftware.com
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When you first start HCA every day you are prompted with an option to backup all your clients. This is an 
option that can be turned off or on underneath the Settings Menu 

 
 

After your selection the Main Screen loads and sample client STN should automatically load. STN is a 
standard chart of accounts which you can use as a template for your new clients, the chart of accounts can 
be easily modified for your personal preferences. 
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Loading Your Clients  

Select the File Menu then the Select/Create Client option. The following screen should appear with a list of 

the sample clients. For this training we will use the STN client – double click on STN and it will load and take 

you back to the main screen. You can have an unlimited number of clients. 
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Duplicating an Existing Client to a New Client Code 

 

Underneath the Client Setup Menu select Duplicate Client Files and the following screen will load. You have 

check boxes for different types of existing data for STN or any client if you want to duplicate that data also. We 

are setting up a completely new client and do not want any data, so no boxes are checked. Type a new Client 

code for your new client, we will use HCA. You can use up to 4 characters either Alpha or Numeric values. 

Now click OK then OK again. Any existing Client can be duplicated. 

 

 
 

 
 

Now click on File and Select/Create Clients now you should see new client code HCA, double click on the 

new client HCA to load it. Now you should see the new client code HCA in the bottom left corner of the screen.  
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Setting up your New Client  

Click on Client Setup Menu and select Client Information and the following screen will load and you will see 

the information duplicated from the client STN – make any changes needed for your new client HCA 

 
 

New information filled in for HCA shows in the next screen shot. We recommend leaving the G/L Account and 

G/L Sub Account Length to 4 and 4 this gives you the ability to use the software for more advanced reporting 

options like departmental statements and Master and Sub account relationships this is explained in more detail 

in the complete manual. Now reload client HCA again and you should see your name change at the left bottom 

of the main screen. 
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The key to using the HCA software is having a correct setup and after that the processing  of your work is 
a breeze. 
 
OK, moving right along the next step is setting up your Chart of Accounts, click on Client Setup and then 
General Ledger and the following screen will load. 
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Click on Display and you will see your duplicated Chart of Accounts. Take a few minutes and review the 

chart of accounts, this is the backbone for the HCA software. You can easily add, edit or delete the chart of 

accounts from this menu. Click on Account # 1101 test 
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Click in the Name field and change test to Payroll Account - NCNB and click OK 
Double click on Account # 1102 and then click on Delete 
This how you can quickly customize the Chart of Accounts for your new clients and have a consistent 
numbering scheme to use. If you click on the Print option shown on next screen shot you have 3 options 
for printing the Chart of Accounts. 
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 After the Fact Payroll Setup  

HCA can automatically perform many of your Payroll functions and work for you (accruing payroll tax 

expenses,etc.). Click on Client Setup and Select the Payroll Setup option then Select Payroll/1099 Records. 

 

 
 

 

 

 

Click on Display and you will see a list of any employees and 1099’s that have been setup, if you Double 

Click on any Name you will see the setup screen – shown on next page 
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Explore some of the different options – The Earnings button allows you to veiw any payrolls recorded and 

allow editing of earnings if needed for Current, Quarter and Year to Date Earnings 

 

If you plan on using the HCA Live Payroll and Check Writer program you would have the Use in Live 

Payroll Program box Checked and then the Personal button is activated for setting live payroll up. 

 

Click the Close button and at the previous screen Select the Add button This brings up a blank setup screen to 

add new Payees 

 

The employee or 1099 number you enter has to be Numeric – The setup of  Vendors requiers an Alpha code. 
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Now select Payroll accounts and enter the correct account numbers 
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Fill out page 1 thru 3 for Payroll & Tax Standards 
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Data Entry 

There are two ways to enter your data, the Cash Journal or the General Journal – Click on the Transactions 

Menu and you will see the two different options 

 

1. Cash Journals 

 
 

2. General Journal 
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Data Entry Screen 

 

 
 

There are several options to make data entry fast – your Enter key will work at this screen and you 

should be able to stay on your keyboard’s 10 key for fast processing 

 

1. Reference field – if you enter a numeric check number like 101 then just hit enter when at the reference 

field again it will automatically click up to the next check – if you have a multiple transaction (or Split) 

hit the + key instead of enter at the reference field, you can have unlimited splits, when the cursor 

returns to the G/L field hit the + key again and it totals your splits and record them, Remember + starts 

splits and + ends splits 

2. The description field is where you would enter an employee number you have setup to record an after 

the fact payroll check and if you setup Vendors you can enter the vendor code or type in anything. 

 

 

This Quick Start manual should get you up and running quickly, you can print the complete manual from 

within the HCA software under the Help menu. The manual is being updated for this new version but all the 

operations in the old manual are basically the same. 

 

We will be posting more training and videos at our Support page. Please call us at 352-589-6438 for any 

help, we have a built in remote hook-up with HCA and will be glad to assist you in anyway. 
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REVIEW - 10 EASY STEPS FOR SETTING UP A NEW CLIENT  
 

1. Load the client that you want to duplicate the chart of accounts – For this training we will copy over 
the STN (Standard Chart of Accounts). From the main menu click on File then the select/create Client 
option and highlight the Client Code STN from the list and click OK this will load the STN sample client. 
 

 

 
 

2. Select Client from main menu & then select the Duplicate client’s files option 
 

 

 
Assign your new client an ID -  Alpha or Numeric and 3 or 4 digits – Then make sure you reselect the 
new Client ID you just created to load the new client. 
 



17 

 

 
 

3. Select the Client menu again and then select the clear all accounts option. 

 

 

4. Select Client General Information from Client Menu again and make necessary changes.   
     

.  
 

5. Select the Client Menu again and then select Payroll then payroll and tax standards and make any 
necessary changes. There are 4 pages, page four requires no information and leave it blank. Click prior 
and then OK to save your changes 
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7. Go to the Payroll/1099 option from the Client Menu and click Add setup new employee enter 
any prior earnings for period, quarter & year to date. 
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8.          From Maintenance menu - select miscellaneous deductions - add, change or delete accounts 
as needed - these are after tax deductions or could be reimbursements not subject to taxes. 

 
 
 

 
9. Go to the General Ledger option from the Maintenance menu. You should Add, Change or 

Delete chart of accounts as needed for your new client. 
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10. From the Main menu, select System then select the System Dates option and set your 
processing date. (08/31/00) for the practice set. 

 

 
 
 

If our STN Standard Chart of Accounts is not numbered in a manner you like you can create from scratch 
your own special standard chart of accounts.  In some cases, such as contractor's job costing, you may 
have to create from scratch. It is recommended however that you do it the easy way and duplicate any 
client you have setup already or the STN. Then you will have consistent account numbers that you will 
eventually memorize and also save yourself a tremendous amount of time.  
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HCA Client Accounting Training Notes 
 

Before starting the practice set you should check your System settings. From the main menu click on 
System 
 

 

 
 
 

1. Accountant’s Information – make necessary changes. This information will appear on your invoice 
and the name fields will print at the bottom of your reports. 

2. System Dates – Displays today’s date and the period ending date for the work you are processing 

 
   

3. Printer Information – Make any changes needed for your printer setup. If you have a laser or inkjet 
printer be sure to have the lines per page set to 59 and if you are using a dot matrix it should be 
66. Select the Printer Setup option and select your printer. We recommend that you use the 
Courier font as shown 
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5. System Information – shows the version number of the software and other information for the 
current client you are working on 

 

 
 

6. The About Screen under the Help Menu tells you the Version you are using 
 

 
 


